
AutoTrac Index

Introduction
Introduction
Getting Started

Menu Commands
File Menu
Edit Menu
Log Menu
Window Menu

Dialog Boxes
Open File 
Save File As
Vehicle Information
Expense
New Expense Category
Maintenance Schedule
Add New Maintenance Category
Modify Maintenance Category
Send
Expense Options
Choose Document
Using Expenses and Maintenance Together

Speedbar
Speedbar Commands



Introduction
Welcome to AutoTrac! AutoTrac is a powerful new program that allows you to track    expenses, 

maintenance information, and a complete service history for each vehicle you own. With AutoTrac you will be able 
to track expenses as personal or business expenses. You may work on several different files in the same session.

AutoTrac allows you to transfer information to your favorite Windows word processor for final touches 
before printing. AutoTrac even allows you to transfer this information to a word processor having several documents
open!

AutoTrac also comes with both a DOS and Windows version of MaintMinder , a program that allows you 
to see which vehicles have upcoming maintenance items due, without the need to run AutoTrac. 

AutoTrac uses enhanced dialog boxes and controls. These have been    made possible with    the following 
excellent programming tool:

Borland Windows Custom Controls (BWCC) by Borland International;

Please note that the file BWCC.DLL must be present either in the AutoTrac directory, or in your PATH for AutoTrac 
to properly operate.



File Menu
The File Menu allows for creating new AutoTrac files, opening existing AutoTrac files, saving files, printing 
information about vehicles, and exiting AutoTrac

Command                    What it does
New Begins a new AutoTrac File
Open Opens a previously created AutoTrac File
Save Saves the active file under a user-specified name
Save As Saves the active file under a new name
Send Allows for sending information from the active file to a Windows word processor
Exit Quits AutoTrac



File | New

The File | New Command    brings up the Vehicle Information Dialog Box. Here you may enter any or all of the 
information requested. This is simply for your records. However, AutoTrac will use the Year, Make, and Model 
information, if    provided, when displaying the Expenses and Maintenance Schedule dialogs boxes. If not, the file 
name will appear in these dialog boxes.

Upon completing the desired information, choose the OK button, or if you wish to cancel, choose the Cancel button. 
If you have entered any information, and choose Cancel, you will be asked if you wish to save the information. 
Choosing Yes or OK will present the information you entered in the Vehicle Information Window.

Once the Vehicle Information Window is open, the menu changes to allow selection of the Expense, Maintenance 
Schedule, and Send options.



File | Open    
AutoTrac files may be opened by choosing File | Open    from the menu, or using the Shortcut Key    F3, or the Open 

speed button from the button bar.    (AutoTrac    automatically displays the command of the button being 
pointed to, at the cursor location, as well as the status bar at the bottom of the Main Window).

The File | Open command displays the Open File Dialog Box  that allows you to    select a file to open.    The default 
extension is ".alg". If you saved a file with a different extension, enter the complete filename i.e., include filename 
plus extension.

AutoTrac can automatically open single or multiple files in a number of ways:
1)    Starting AutoTrac with the files listed as command line arguments. For example, to start AutoTrac,    and    
automatically open the files "mycar.alg" and "mytruck.alg", using the Windows File | Run menu command, type 
[path name]AutoTrac.exe    mycar.alg    mytruck.alg.

If the AutoTrac directory is in your PATH statement, you may start Windows, start AutoTrac and open files with the 
command :    win AutoTrac mycar.alg mytruck.alg.

2)    A much easier way is to start AutoTrac , then start Windows' File Manager. Select the AutoTrac file(s) you wish 
to open from File Manager, and simply drag and drop them into the AutoTrac Main Window, or the AutoTrac icon, if
minimized..

3) An alternative approach is to use File | Associate from Windows File Manager, and associate files with the ".alg" 
extension with AutoTrac. Then, by simply selecting the file and pressing Enter or double-clicking with the mouse, 
AutoTrac will be started, and the file will be opened automatically. (See your Windows manual for details on 
associating files.)



File | Save    
To save a currently open file, choose File | Save from the menu, use the Shortcut Key F2, or click on the Save speed 
button from the button bar. (AutoTrac    automatically displays the command of the button being pointed to, at the 
cursor location, as well as the status bar at the bottom of the Main Window).

This saves the document in the active Vehicle Information Window to disk. If the document is unnamed (the title bar
will display "Untitled.alg"), the Save File As Dialog Box is displayed so you can name the file, and choose where it 
is to be saved. The default extension is ".alg", although you may save the file under any name you wish. (Please 
note,
however, that the File Open dialog box automatically displays only files with the default extension).

Once    a file has been saved, the title bar in the Vehicle Information Window will display the new filename.



File | Save As

If you wish to rename a file, or save a file under a new name, choose File | Save As from the menu. The File Save As
dialog box is displayed. Follow the steps under File | Save
 



File | Send    
Because there are so many ways to present information about a vehicle, including expenses, maintenance schedules, 
etc. it was a deliberate design decision not to incorporate a printing option into AutoTrac. Instead, AutoTrac lets you 
select a Windows word processor to send the information to, allowing you complete freedom as to how to print the 
information.

To send information to a word processor, choose    File | Send from the File Menu, use the Shortcut Key F7, or click 
on the Send speed button from the button bar. (AutoTrac automatically displays the command of the button being 
pointed to, at the cursor location, as well as the status bar at the bottom of the Main Window).

This will display the Send Dialog Box. Simply select the information that you desire to have placed in the word 
processor (See Selecting a Word Processor later in this section).



File | Exit    
To exit AutoTrac, choose    File | Exit from the File Menu, use the Shortcut Key Alt-X, or click on the Exit speed 
button from the button bar.    (AutoTrac    automatically displays the command of the button being pointed to, at the 
cursor location, as well as the status bar at the bottom of the Main Window).

If you currently have any unsaved documents, AutoTrac will highlight the Vehicle Information window, and will ask
you if you wish to save the document. Select Yes to save, or No to continue.

If you have run AutoTrac Help, it will automatically close when AutoTrac exits.



Edit Menu
The Edit Menu has only one command : Edit Vehicle Information. Selecting this command will bring up the Vehicle 
Information Dialog Box with the current information displayed from the Vehicle Information Window.    Simply 
make the desired changes and choose OK. The changes will immediately be reflected in the Vehicle Information 
Window.

However, to make the changes permanent, you will need to save the file. AutoTrac will prompt you to save the file 
before you use the Expense or Maintenance Schedule, or before you attempt to close the Vehicle Information 
Window, or exit AutoTrac .

This option may also be selected by clicking with the right mouse button in the Vehicle Information Window.



Speedbar Commands
The Speedbar is a row of buttons at the top of the main window which are shortcuts for commands from the menu.    
The buttons are described below.

Button Menu Equivalent

 File | Exit

        File | Open

        File | Save

Log | Expenses

Log | Maintenance Schedule

File | Send



Vehicle Information Dialog Box

Here you may enter any or all of the information requested. This is simply for your records. However, AutoTrac will
use the Year, Make, and Model information, if    provided, when displaying the Expenses and Maintenance Schedule 
dialogs boxes. If not, the file name will appear in these dialog boxes .

Upon completing the desired information, choose the OK button, or if you wish to cancel, choose the Cancel button. 
If you have entered any information, and choose Cancel, you will be asked if you wish to save the information. 
Choosing Yes or OK will present the information you entered in the Vehicle Information Window.

Once the Vehicle Information Window is open, the menu changes to allow selection of the Expense, Maintenance 
Schedule, and Send options.



Vehicle Information Window
The Vehicle Information Window displays the information entered in the Vehicle Information Dialog Box. The 
arrow keys allow you to scroll the window.

Clicking with the right mouse button in this window will bring up the Vehicle Information Dialog Box



Main Window
This is the AutoTrac Main Window. Once files have been created, or opened, their Vehicle Information Window will
appear here. The Vehicle Information Windows may be minimized, maximized, cascaded, tiled, or moved within this
window. Double-clicking on a minimized window (displayed as an icon) will re-open the Vehicle Information for 
that vehicle.

To open AutoTrac files by drag -and-drop, drag the files from Windows File Manager into this window. For further
information, see File | Open



Expenses    

See Also: Using Expenses and Maintenance Together

AutoTrac allows you to enter and edit Expense information for your vehicle.

Choose Log | Expenses, or use the Shortcut Key    Ctrl-L, or click on the Expense speed button from the button bar.   
(AutoTrac    automatically displays the command of the button being pointed to, at the cursor location, as well as the 
status bar at the bottom of the Main Window). This displays the    Expense dialog box. The year, make, and model of
the vehicle, if present in the Vehicle Information Window, is presented as the title. If not, the file name is the title.

Note: If you have not saved any changes to the file, you will be prompted to do so prior to being given access to the 
Expense dialog box.

An explanation of the fields is as follows: Note that two fields (Date and Total Cost) must    be filled in, while others
contain optional    information or default    values.

Date:
This is NOT an optional field. A valid date must be entered.
The current system date is presented as the default date. If this is not correct, enter the date the expense was incurred
as either of the following formats:
                                  MM-DD-YY    (01-27-94)
                                  MM/DD/YY    (01/27/94)
                                  MM,DD,YY    (01,27,94)
                                  Month DD,YY (January 27, 1994)
                                  Mon. DD,YY    (Jan. 27, 94)
A combination of these formats is also acceptable.

Unit Cost:
This is an optional field
Enter the cost-per-item amount. Examples are dollars per gallon of gasoline, price per quart of oil, etc.

Total Cost:
This is NOT an optional field. A total cost must be entered.
Enter the total cost of the expense.

Description:
This is an optional field.
Enter a description of the expense if desired

Location:
This is an optional field.
Enter the location where the expense was incurred.    Suggested ideas are: the store where an item was purchased; 
the service station where expense was incurred, etc. 

Mileage:
This is an optional field.
If desired, enter the vehicle mileage at the time of the expense.
However, if the expense is to be added to the Service History, you will need to enter a mileage

Choose Expenses Box:
Select the type of expense from the Choose Expense drop-down    box. The default selection is "Gasoline". If the 



type of expense you need is not found, you may add a    new expense type by selecting the Add New Category 
button. This will bring up the Add New Category dialog box.
Simply type in the new expense category, choose OK, and the expense will be added to the Choose Expense box. 

Expense Type:
This is an optional field, the default being "Personal".
Choose either the "Personal", or "Business" radio button depending on the type of expense. AutoTrac will keep track
of your expenses as either Business or Personal. When the expenses are sent to a word processor, AutoTrac can send 
either type, or both, with separate totals and    descriptions for each.

Add New Category: 
As mentioned above, selecting this button will bring up the Add New Category dialog box. Simply type in the new 
expense category you wish, and it will be added to the Choose Expense box. 

Total Expenses: 
If no expense file exists for this vehicle, this button will be dimmed, otherwise it will be active. Choosing Total 
Expenses will display the Total Expenses for this vehicle, broken down as Total Personal Expenses and Total 
Business Expenses.
Select OK to close this box.

View Previous: 
Selecting this button allows you to view and edit previous expenses. Once the first expense has been reached, this 
button will be dimmed.

View Next: 
Used in conjunction with View Previous, View Next allows you to view and edit the next expense.

Done Viewing: 
If you are in the middle of viewing expenses, selecting Done Viewing will clear the dialog box and allow you to 
begin entering new expenses.

Add to Service History: This will add the applicable information to the vehicle's Service History File. The 
following information will be added: Date, Expense, and Mileage. The expense will appear as "Replace" when 
viewing the Service History File.



Maintenance Schedule    

See Also: Using Expenses and Maintenance Together

Choose Log | Maintenance Schedule , or use the Shortcut Key    Ctrl-M, or click on the Maintenance speed button 
from the button bar. (AutoTrac    automatically displays the command of the button being pointed to, at the cursor 
location, as well as the status bar at the bottom of the Main Window). This displays the Maintenance Schedule    
dialog box. The year, make, and model of the vehicle, if present in the Vehicle Information Window, is presented as 
the title. If not, the file name is the title.

Note: If you have not saved any changes to the file, you will be prompted to do so prior to being given access to the 
Maintenance Schedule    dialog box.

An explanation of the fields and buttons is as follows:

Miles Driven Per Month:
The default value of 1,000 is presented. Alter this If necessary for your vehicle. You are allowed to use only whole 
numbers. The maximum allowable entry is 99,999

Category Box:
Several Maintenance categories are presented in this drop down box. The months / miles numbers give suggested 
values for the number of months or miles between scheduled maintenance. You may alter these default values by 
selecting the Modify button.
Choose the category that described the maintenance performed on the vehicle. If a category is not listed, you may 
add a new one with the Add button.

Inspect / Replace:
This field indicates whether the maintenance is An inspection of the item, or a replacement. You may change this 
setting by selecting the Modify Button (see below).

Date Maintenance Last Performed:
If no maintenance file is available for this vehicle, this field displays the system date as the default.

Add: 
This brings up the Add New Maintenance Category Dialog Box. 
Enter in the new category, the number of months and miles required between maintenance, whether the maintenance
requires inspection or replacement of the item, and the date the maintenance was last performed. Choose OK to save
this information.
This new maintenance item will now be available for this vehicle only.

Delete:    
This will delete the chosen maintenance item(s) from the list    box. You will be prompted to confirm that the item(s) 
is (are) to be deleted. You may select more than one item to be deleted. To select continuous items: with the 
keyboard, hold down the Shift key, while using the Up / Down arrows to select. With the mouse, hold down the left 
mouse button, and drag the mouse to select.    To select non-contiguous items: with the keyboard, highlight the first 
item, press Shift-F8, use the arrow keys to move to each remaining item you want to select, press the Spacebar to 
select each item, press Shift-F8 again. With the mouse, select the first item, press and hold down Ctrl while you 
select each remaining item. Release the Ctrl key.



Modify: 
The Modify button brings up the Modify Dialog Box. Here you may change the default values for the number of 
months and / or miles between scheduled maintenance,    whether you prefer the    maintenance to be replacement or 
inspection of the item, or to change the date the maintenance was performed.    You may select one, or several items 
to modify at once. (See above paragraph under "Delete"    for steps to select several items ) When you select several
items to modify, the Modify Dialog Box displays the selections as "First Item ... Last Item". The individual controls 
are set to the last item selected.    Changing the values and selecting OK will change all the selected items to the 
new values.

Overdue:    
This will bring up a window displaying all the maintenance currently overdue for this vehicle (as of the current 
system date). This information may be sent to a word processor using File | Send.

Upcoming:    
This will bring up a window displaying all the maintenance that will be due in the next 30 days, including any 
overdue items. This information may be    sent to a word processor using File | Send

Add to Service History: This will add the applicable information to the vehicle's Service History File. 



Send Dialog Box
The Send Dialog Box is displayed by selecting    File | Send from the File Menu, use the Shortcut Key F7, or click 
on the Send speed button from the button bar.  (AutoTrac automatically displays the command of the button 
being pointed to, at the cursor location, as well as the status bar at the bottom of the Main Window).

The Send Dialog Box displays options for sending information to a Windows word processor.

When selecting expenses, AutoTrac offers you the option of sending all the expenses incurred for a vehicle, or 
selectively choosing expenses by year, month, and type (business, personal, or both). If you wish to send all 
expenses, choose the Send All option under the Expenses section. If you wish to selectively choose expenses, select 

the Choose button. (  ) This displays the Expense Options dialog box. Here you must enter the expense 
year desired. Select the month(s) from the Expense Month(s) section, and the type (business, personal, or both) from
the Type section. Choose OK to close the dialog box.

If    more than one instance of the selected word processor is running (i.e., two Notepads each with a different 
document), or if your word processor has multiple document capabilities and more than one document is loaded, 
AutoTrac will present you with the Choose Document dialog box. Here you may select which document to send the 
information to, even in a multiple document word processor. Note: if the document you wish to send information to 
is part of    a multiple document word processor, it does not have to be the active document. AutoTrac will still send 
the information to the correct document.

Selecting a Word Processor
AutoTrac places the two standard Windows word processors, Notepad and Write in the Send To drop-down box. 
Type Alt-S , or click on the down arrow to highlight this box.
Use the up or down arrow keys to select which word processor to send the information to. If    you wish to add 
another word processor of your choice to this list, see the next section    (Adding Word Processors).

Important! The word processor you select must be currently running prior to sending information.

Adding Word Processors
To add an additional word processor to the list of word processors that appear in the Send To drop-down box, select 
the box by typing Alt-S, or clicking on the down arrow with the mouse. Be sure the displayed text is 'selected' i.e., is 
displayed in reverse video. Then type the name of your word processor as it appears in the title bar without the 
document name. For instance Notepad - (Untitled) is entered simply as Notepad; Write - Manual.wri is entered 
simply as Write, etc. The selected text will be replaced with the text you type in. Then simply choose OK to continue
with sending the vehicle information.

AutoTrac automatically saves the word processor you enter, and it will appear each time you run AutoTrac.

Note: There is currently no option to remove a word processor from this list once it has been entered.



Expense Options
The Send Expenses dialog box allows you to selectively choose which expenses to send to your word processor. You
may choose the year, month(s) and type(s) of expenses.

Enter the desired year of the expenses you wish to send. You must enter a valid year i.e., 1995    (not    '95, etc.)

Select the month(s) using the check boxes. You may select any month or months desired.

Select the type of expense    - Personal, Business, or Both.



Add New Category Dialog Box    
The Add New Category dialog box allows you to enter a new expense category to be displayed in the Choose 
Expense drop-down box in the Expense dialog box.

Enter the category of the expense you wish to add. 

Note -    this expense will now be available for all vehicles



Add New Maintenance Category        
The Add Maintenance Category dialog box is displayed by selecting the Add button form the Maintenance Schedule 
Dialog box.

Type in the new category desired.

Enter the number of months and miles between scheduled maintenance periods. 

Select whether the maintenance requires inspection or replacement of the item.

Type in the date the maintenance was last performed. If this field is left blank, the current date will be used.

Choose Add to Service History to add this new category to your vehicle's Service History File



Modify Maintenance Category    
The Modify Maintenance Category dialog box is displayed by selecting the Modify button form the Maintenance 
Schedule Dialog box.

If only one category was selected, the current settings for the maintenance category selected will be filled in the 
appropriate fields. If more than one category was selected, the settings for the last category selected will be 
displayed.
 
Modify the fields that require changing, and choose OK    Note that if no date is entered the current date will be 
used.

Note:  If more than one category was selected,    changing the values and selecting OK will change all the selected 
items to the new values.

Choose Add to Service History to add this new category to your vehicle's Service History File



Log Menu

The Log Menu has three choices:

Expenses            -      This brings up the Expenses dialog box.
Maintenance -      This brings up the Maintenance dialog box.
View Service History - Allows you to view the current Service History File for your vehicle



Window Menu
The window menu has commands that control the appearance of the windows in the AutoTrac Main Window:

Cascade    - overlaps and offsets the windows so that the title bars are visible.
Tile              - arranges windows so that all open windows will fill the Main Window.
Arrange Icons    - Arranges minimized windows in a row along the bottom of the Main Window.
Close All    - closes all windows, leaving a blank Main Window.



Open File Dialog Box

The Open File Dialog Box is displayed in response to the File | Open command form the main menu, by pressing the
Shortcut Key  F3, or by clicking on the Open Speed button    .

By default, the Open File Dialog Box displays all files in the working directory with the default extension of ".alg". 
If you saved your file with a different extension, you will need to type in the correct filename in the entry field. For 
example    "mycar.bob".

Select OK to open this file. If the file you attempt to open is not an AutoTrac file, you will receive the error message 
"Not an AutoTrac File!"

AutoTrac will open the file and the Vehicle Information Window for that vehicle will appear.



Save File As Dialog Box
The Save File As Dialog Box is displayed as a result of selecting File | Save As from the menu, or if selecting    File |
Save and the file currently is unnamed (the title bar    in the Vehicle Information Window displays "Untitled.alg").

The current title in the Vehicle Information Window is set as the default name under which to    save the file. To save
the file under a different name, type the new name in the text entry field. 

Note: The file will automatically be saved with the ".alg" extension unless you specifically type a different 
extension. For example, if you enter "mycar" (without the quotation marks), your file will be saved as "mycar.alg". 
However, if you enter "mycar.mom" (without the quotation marks), your file will be saved under that name.

The new name will now be displayed in the title bar    in the Vehicle Information Window.



Choose Document Dialog Box
The Choose Document Dialog Box is displayed if you try to send information to a word processor, and either of the 
following is true:

1). More than one instance of that word processor is currently running. 
        For example, there may be two Notepads running at the same time.

 2). The Windows Word Processor you have added has multiple document capabilities, i.e., more than one document 
may be opened at the same time    (some examples are Microsoft Word,    Ami Pro, Microsoft Works, etc.), and you 
currently have more than one document open.

The Choose Document dialog box will appear and ask you to choose which document to send the information to. 
Select the correct document (see examples below), and choose OK.

Examples:

In the first case mentioned above,    perhaps there are two Notepads currently running. One has a file open 
called "myfile.txt", the other is blank ( a new file - "Untitled"). You have chosen to send the information to Notepad. 
AutoTrac needs to know which Notepad to send the information to. The Choose Document dialog box will have the 
title "Select Notepad Document" and will    list both entries, "myfile.txt", and "untitled".    Use the Up / Down arrow 
keys to select the one to send the information to and select OK. AutoTrac will now send the information to the 
correct Notepad.

In the second example, suppose you have chosen to send the information to Ami Pro. Ami Pro is running 
with 3 documents open: "one.sam", "two.sam", and "three.sam".    The Choose Document dialog box will have the 
title "Select Ami Pro Document" and will    list    entries, "one.sam", "two.sam",    and "three.sam".    Use the Up / 
Down arrow keys to select the one to send the information to and select OK. AutoTrac will now send the 
information to the correct document inside Ami Pro. Note:  The document you choose does not have to be the active
document. It may even be minimized as an icon. AutoTrac will still send the information to the correct document.



Using Expenses and Maintenance Together

There will be instances where an expense incurred is a result of maintenance due. For example, purchasing belts, oil,
air filters, etc. might be required if you are performing the maintenance yourself. Or perhaps your mechanic has 
billed you for the scheduled maintenance. In such cases, you would enter the cost of the items, labor, etc. in the 
Expense box under the appropriate category (or categories), and would then update the 'Date Maintenance Last 
Performed'    section    in the Maintenance Schedule box. This way, you have an effective method for categorizing 
and tracking vehicle expenses, while keeping track of maintenance performed.



Getting Started
This section will help you get up and running with AutoTrac.    The following outline will give you an idea of how 
to begin.

You will first need to create a file for the vehicles you wish to track. See File | New
Save the file.    See File | Save.

              At this point you may choose to either add, delete, or modify the default maintenance categories to match    those   
in your owner's manual. (See Maintenance Schedule). You may also begin adding entries to your Service History 
File. ( See Creating A Service HistoryFile)
You may also opt to begin entering the expenses incurred for your vehicle (See Expenses)

Please be sure to read the information and suggestions under Creating a Service History File. 



Creating a Service History File
By creating a Service History file, you will be able to print out (via Sending the information to a Word Processor) all
the service, maintenance, repairs, etc. that have been performed on your vehicle.

The Service History File records the following information :
The category of the service (i.e. Oil Change, New Tires, Tune-Up...);
The date the service was performed;
The    vehicle mileage when the service was performed;
The action taken (Replacement of part(s), or Inspection ).

Items may be added to the Service History file from three separate locations:
The Expenses dialog box;
The Add Maintenance Category dialog box (using the Add button in the Maintenance Schedule dialog box);
The Modify Maintenance Category dialog box (using the Modify    button in the Maintenance Schedule dialog 

box);

From all three locations, simply choose the Add to Service History button in these dialog boxes. The appropriate 
information will be added to the Service History File.    When the Service History File is viewed, or sent to a word 
processor, the items are listed by mileage, with the lowest mileage entries appearing first. 

Suggestions:
When adding information to the Service History File using the Modify Maintenance Category dialog box and / or 
the Add Maintenance Category dialog box,    if possible, add the information beginning with the oldest date, and 
working up to the most recent. Although this will not affect the way the History File is displayed, it will affect the 
date and mileage numbers displayed in the Maintenance Schedule dialog box, once you return. This, in turn, will 
cause the Upcoming and Overdue selections to incorrectly report that the maintenance is overdue, etc. when it may 
not be. Of course, you would only need to Modify these categories to reflect the most current date and mileage 
changes to correct this. 

See also Viewing the Service History File    



Viewing the Service History File

A portion of the Service History File may be viewed in AutoTrac by selecting Log | View Service History, or using 
the Shortcut Key Ctrl-H.

The entries are displayed by category, date, and ascending mileage. The action taken (Inspect / Replace) is not 
displayed. 

See also : Creating A Service History File



Windows Keys
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

Arrow key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or Ctrl+Left Arrow Moves to the beginning of a field.
Pape Up or Page Down Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

Tab Moves from field to field (left to right and top to bottom).
Shift+Tab Moves from field to field in reverse order.
Alt+letter Moves to the option or group whose underlined letter matches 

the one you type.
Arrow key Moves from option to option within a group of options.
Enter Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

Esc Closes a dialog box without completing the command. (Same as
Cancel)

Alt+Down Arrow Opens a drop-down list box.
Alt+Up or Down Arrow Selects item in a drop-down list box.
Spacebar Cancels a selection in a list box.

Selects or clears a check box.
Ctrl+Slash Selects all the items in a list box.
Ctrl+Backslash Cancels all selections except the current selection.
Shift+ Arrow key Extends selection in a text box.
Shift+ Home Extends selection to first character in a text box.
Shift+ End Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

Shift+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.
(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type, when a menu has focus.
Alt+Letter key Pulls down the menu whose underlined letter matches the one 

you type.
Left or Right Arrow Moves among menus of the main menu bar.
Up or Down Arrow Moves among menu items within a drop-down menu.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

Shift+Left or Right Arrow Selects text one character at a time to the left 
or right.

Shift+Down or Up Selects one line of text up or down.
Shift+End Selects text to the end of the line.
Shift+Home Selects text to the beginning of the line.
Shift+Page Down Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

Shift+Page Up Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

Ctrl+Shift+Left or Right Arrow Selects text to the next or previous word.
Ctrl+Shift+Up or Down Arrow Selects text to the beginning (Up Arrow) or end

(Down Arrow) of the paragraph.
Ctrl+Shift+End Selects text to the end of the document.
Ctrl+Shift+Home Selects text to the beginning of the document.



Window Keys

Key(s) Function

Alt+Spacebar Opens the Control menu for an application window.
Alt+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+Enter Switches a non-Windows application between running in a 

window and running full screen.
Arrow key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.






